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1 Introduction

1.1 About NITRO-Player

NITRO-Player is a tool that supports the creation of sound data for the Nintendo DS system

(henceforth referred to as “DS”). It allows playing the sound data created for NITRO-Composer on the

DS, making it possible for users to hear their creations.

With NITRO-Player, the user can play and stop sounds, and perform other operations with the help of a

PC mouse and keyboard. Because playback is routed through the DS, the user can check how sounds

will play once they are incorporated into a game. For the parameters that can be changed while the

game is playing, such as tempo and volume, NITRO-Player can also check and adjust sounds in real

time.

1.2 About this Manual

This manual covers the fundamentals of using NITRO-Player, providing easy explanations about

frequently used features. The basic components, steps for configuration, and preparation for use of the

NITRO-Player are explained. Examples are then used to help explain the basic procedure for using the

NITRO-Player.

This manual provides you with the NITRO-Player basics. To make full use of the program, you must be

familiar with NITRO-Composer. We recommend that you read the NITRO-Composer Overview manual

before using the NITRO-Player.
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2 Preparing NITRO-Player

2.1 Composition

2.1.1 Schematic Diagram

NITRO-Player consists of the components shown in Figure 2-1.

Figure 2-1 NITRO-Player Schematic

2.1.2 Software

2.1.2.1 NITRO-Player Application

The purpose of this Windows application is to load the sound data and to play and stop sound playback.

This application will be referred to as "NITRO-Player" unless otherwise noted.

2.1.2.2 MCS Server

This Windows application is essential for communication between the PC and the Nintendo DS.

2.1.2.3 NITRO-Player Nintendo DS System Program

This sound playing program runs on the Nintendo DS.
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2.1.3 Hardware

To use NITRO-Player on the Nintendo DS hardware, connect to a PC in one of the following

configurations.

� IS-NITRO-EMULATOR hardware (blue box)

Figure 2-2 Connection with the IS-NITRO-EMULATOR Hardware (Blue Box)

PC

USB

� A DS system connected to IS-NITRO-UIC and a DS development-use flash card

Figure 2-3 Connection with the IS-NITRO-UIC and the Nintendo DS System

DS development

Flash Card for

PC
USB

IS-NITRO-UIC

However, to use the playback features on a MIDI device, use one of the following configurations.

� IS-NITRO-EMULATOR hardware (blue box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI)

Figure 2-4 Connection with the IS-NITRO-EMULATOR (Blue Box) and the IS-NITRO-UIC MIDI (or IS-AGB-MIDI)

PC USB

IS-NITRO-UIC MIDI

(or IS-AGB-MIDI)

MIDI device

MIDI
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� A DS system connected to IS-NITRO-UIC MIDI and a DS development-use flash card

Figure 2-5 Connection with the IS-NITRO-UIC MIDI and the Nintendo DS System

Flash Card for
DS development

PC
USB

IS-NITRO-UIC MIDI

MIDI device

2.2 Setup

NITRO-Player is included with NITRO-System. If NITRO-System is set up, NITRO-Player is ready for

use.

The following is a simple explanation of how to configure NITRO-System. If NITRO-System is already

set up, the following procedure is unnecessary. For more details, read the NITRO-System

documentation.

2.2.1 Extract the Package

Decompress the NITRO-System package using a decompression tool.

2.2.2 Set Environment Variable

Set the environment variable NITROSYSTEM_ROOT to the absolute path for the extracted directory

NitroSystem. Everything included in this directory is indicated by $NitroSystem.

2.3 NitroPlayer Directory

Files associated with NITRO-Player are stored within the NitroPlayer directory. The path to the

NitroPlayer directory is $NitroSystem\tools\win\NitroPlayer.

Everything within this directory is hereafter indicated using $NitroPlayer\. 
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3 Basic Operations

3.1 Starting NITRO-Player

There are a number of ways to start NITRO-Player, and the methods vary depending on the hardware

configuration. Select the appropriate configuration based on your hardware.

� Running IS-NITRO-EMULATOR hardware (blue box)

� Running IS-NITRO-UIC and the Nintendo DS system

� Running IS-NITRO-EMULATOR hardware (blue box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI)

� Running IS-NITRO-UIC MIDI and the Nintendo DS system

3.1.1 Running with the IS-NITRO-EMULATOR Hardware (Blue Box)

Figure 3-1 Connection with the IS-NITRO-EMULATOR Hardware (Blue Box)

PC

USB

(1) Check that the IS-NITRO-EMULATOR hardware (blue box) is correctly connected to the PC. If
another application is running on the blue box, you must shut it down before starting NITRO-Player.

(2) Start MCS Server from the PC. Click the shortcut $NitroPlayer\mcsserv_EMU. Once MCS Server
starts, the NITRO-Player DS will start automatically on the DS. Wait for the NITRO-Player logo to
appear on the screen.

(3) Start the NITRO-Player application from the PC. Execute $NitroPlayer\NitroPlayer.exe.
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3.1.2 Running with IS-NITRO-UIC and Nintendo DS System

Figure 3-2 Connection with the IS-NITRO-UIC and the Nintendo DS System

DS development

Flash Card for

PC
USB

IS-NITRO-UIC

(1) To start NITRO-Player on a DS system, you must first write the NITRO-Player DS program to a DS
flash card used for development. The executable file to write is $NitroPlayer\nito\ARM9-
TS\Release\NitroPlayer.srl.

(2) Check that the PC and the DS are connected via IS-NITRO-UIC. If another application is running
on the DS, you must shut it down before starting NITRO-Player.

(3) Turn on the DS power and start the NITRO-Player DS program. Wait for the NITRO-Player logo to
appear on the screen.

(4) Start MCS Server on the PC. Execute using the shortcut $NitroPlayer\mcsserv_UIC.
(5) Start the NITRO-Player application on the PC. Execute $NitroPlayer\NitroPlayer.exe.
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3.1.3 Running with IS-NITRO-EMULATOR Hardware (Blue Box) and IS-NITRO-UIC
MIDI (or IS-AGB-MIDI)

Figure 3-3 Connection with the IS-NITRO-EMULATOR (Blue Box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI)

PC USB

IS-NITRO-UIC MIDI

(or IS-AGB-MIDI)

MIDI device

MIDI

(1) Check that the IS-NITRO-EMULATOR hardware (blue box) is correctly connected to the PC. If
another application that connects to the IS-NITRO-EMULATOR hardware (blue box) is running,
you must shut it down before starting NITRO-Player.

(2) Insert IS-NITRO-UIC MIDI (or IS-AGB-MIDI) into the GBA Game Pak slot of the IS-NITRO-
EMULATOR.

(3) Start MCS Server on the PC. Execute using the shortcut $NitroPlayer\mcsserv_EMU_MIDI. Once
MCS Server starts, the NITRO-Player DS program will start automatically on the DS. Wait for the
NITRO-Player logo to appear on the screen.

(4) Start the NITRO-Player application on the PC. Execute $NitroPlayer\NitroPlayer.exe.

Do not remove a Game Pak or insert it into the GBA Game Pak slot of the IS-NITRO-

EMULATOR while MCS Server is running. First, make sure MCS Server has stopped.
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3.1.4 Running with IS-NITRO-UIC MIDI and the Nintendo DS System

Figure 3-4 Connection with the IS-NITRO-UIC MIDI and Nintendo DS System

Flash Card for
DS development

PC
USB

IS-NITRO-UIC MIDI

MIDI device

(1) To start NITRO-Player on the DS, you must first load the NITRO-Player DS program to the flash
card for DS development. Load the executable file $NitroPlayer/nito/ARM9-
TS/Release/NitroPlayer.srl.

(2) Confirm that the PC and the DS are connected via IS-NITRO-UIC MIDI. Any other applications
running on the Nintendo DS must first be shut down.

(3) Turn ON the DS power, and run the NITRO-Player DS program. Wait for the NITRO-Player logo to
appear on the screen.

(4) Start the MCS server on the PC. Run the shortcut called $NitroPlayer/mcsserv_UIC.
(5) Start the NITRO-Player application from the PC. Run $NitroPlayer/NitroPlayer.exe.
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3.2 Start Window

If NITRO-Player has started correctly, the window shown in Figure 3-5 will appear on the screen.

Figure 3-5 NITRO-Player Start Window

If NITRO-Player is properly connected to a Nintendo DS system, the status bar will display

"CONNECT" as shown in Figure 3-6.

Figure 3-6 Indicator

If "CONNECT" does not appear, the connection with the DS has not been established. Check the

connection for any problems.

"MIDI", displayed to the left of "CONNECT" on the status bar, indicates that the real-time MIDI playback

feature is in use. If "MIDI" is not displayed, the real-time MIDI playback feature is disabled.
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3.3 Opening Sound Data

With NITRO-Player running, the next step is to load sound data. Open the sound data in the file

$NitroSystem\tools\nitro\SoundPlayer\data\sound_data.sar. There are different ways

to open the file.

� From the File menu, select Open and choose the file from the dialog box

� Drag and drop the file into the NITRO-Player window

When the file is opened, a window will appear. This window remains displayed during the conversion of

the sound data, and then closes when the conversion is completed. Once the conversion completes

successfully, the window shown in Figure 3-7 appears. 

Figure 3-7 Opened Sound Data

Here, a sound archive definition file (*.sarc) has been opened, but a sound archive (*.sdat) can also be

opened. If a sound archive is opened, conversion will not be performed during loading.
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3.4 Displaying Sound Data

Opening the sound data caused several items to be displayed in the left pane, which shows the

structure of the data within the sound archive. Each item that has a folder icon corresponds to a section.

Select the SEQ section to display its contents.

Figure 3-8 Selected SEQ Sequence

As shown in Figure 3-8, the contents of the selected folder in the folder pane (left) appear in the content

pane (right) of the NITRO-Player window. In this case, the content of the SEQ folder or a list of

sequence data appears in the content pane. The data size and information about the bank being used

are also shown.

Click on other folders in the folder pane to display their contents.

3.4.1 Sorting Items

Click on column headers in the content pane to sort and order the content. Clicking the header twice

will toggle the order between ascending and descending.
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3.5 Start/Stop Sequence

To play the sequence, select the SEQ folder. Select the sequence in the content pane, and in the Play

menu select Playback. The requested data are transferred and played on the DS.

To stop the playback, from the Play menu select Stop. To pause the sound, from the Play menu select

Pause. To resume playback, select Pause again. If a sequence is paused and Playback is selected,

the sequence will play from the beginning.

For sequence playback, the sound data are sent from the PC to the Nintendo DS as necessary. This can

result in a delay between the time Play is selected and the time the actual playback begins.

3.6 Precautions for Quitting the Application

To quit the application, reverse the startup procedure.

(1) Quit NITRO-Player
(2) Quit MCS Server
(3) If necessary, turn the DS power off
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4 Player Window

4.1 About the Player Window

In the main application window, you can perform operations such as starting or stopping sequence

playback. However, to play multiple sequences at the same time, you must use the Player window,

shown in Figure 4-1.

Figure 4-1 Player Window

Sequences can also be played back and stopped in this window.
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4.2 Opening a Player Window

As shown in Figure 4-2, each of the 16 numbered buttons in a row on the toolbar corresponds to one

Player window.

Figure 4-2 Player List Toolbar

Click one of these buttons to open a Player window. Clicking the same button repeatedly will show and

hide the Player window.

At most 16 Player windows can be displayed at one time.
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4.3 Playback Method

First, using the two drop-down list boxes as shown in Figure 4-3, select the sound you want to play.

Figure 4-3 Player Window (Sound Selection)

Select Sound Type

Select Individual Sound

The Select Sound Type list determines the type of playback sound. The three available sound type

options are: Sequence, Stream, and Sequence Archive. If you choose Sequence Archive, any

sequence archive can be selected. The Select Individual Sound list allows you to select the

sequence or stream to be played back.

After selecting these settings, the sound can be played back from the Player window in the same way

that it is played from the main application window. However, if you use shortcut keys for playback, the

sound will play in the active window.
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5 Sequence Panel

5.1 About Sequence Panel

The Sequence Panel dialog box allows you to recreate most of the operations that a game program

can execute, for example, muting and volume adjustment.

To open Sequence Panel, from the View menu select Sequence Panel. This opens the Sequence

Panel dialog box shown in Figure 5-1.

Figure 5-1 Sequence Panel

For example, moving the Tempo slider while playing a sequence will change the tempo in real time.
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5.2 Sequence Panel Features

This section describes the features of the Sequence Panel dialog box introduced in the preceding

section.

5.2.1 Enable Checkbox

Selecting to clear the Enable check box disables all of your configured settings and restores the default

settings in Sequence Panel. Selecting the Enable check box again re-enables your configured

settings.

5.2.2 Fade-In and Fade-Out

Set values for Fade-In and Fade-Out to fade in and out the sound when sequences begin and end.

The unit value is one frame.

5.2.3 Skip

If Skip is given a value, playback starts from a designated position. The unit of measure is one tick.

A greater number of skips increases the skip process and will delay the start of playback. There are

cases where additional sounds do not play correctly during the skip process.

5.2.4 Tempo

The tempo of the sequence can be changed by setting its percentage value. The value 256 represents

full tempo (100%), or no change in tempo. Click Reset to revert to the initial value of 256.

5.2.5 Player Volume

Use this setting to change the player volume for the sequence. The value 127 represents full volume

(100%), or no change in volume. Click Reset to revert to the initial value of 127.
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5.2.6 Track Parameters

This set of 16 slider bars is associated with the 16 tracks in the sequence. Using the appropriate slider,

adjust the three parameters, Volume, Pitch, and Pan, for each track. From the drop-down list box

above the sliders, choose a parameter to set. The three parameters are described in Table 5-1.

Table 5-1 Meanings of the Track Parameter Values

Parameter Meaning of the Values

Volume Values are between 0 and 127, which corresponds to 0% to 100% of volume.

Pitch Positive values raise the pitch; negative values lower the pitch.

A value of 64 changes the pitch by a half-tone. (12 half-tones = 1 octave)

Pan Positive values move pan (location) right; negative values move pan left.

Pan = 0: sound is centered

Pan = +64: output only from the right

Pan = -64: output only from the left

Once a parameter has been changed, it remains in that state when you select another parameter. If

you return a parameter to its original value, the slider reverts to the position where it was the last time

the parameter was set. Each Reset button to the right of the slider restores the settings of the current

parameter to its initial value. Reset Sliders restores the currently selected parameter to the initial

values for all of the tracks. Reset All Sliders restores all parameters, including those that are not

selected, for all of the tracks to their initial values.

5.2.7 Mute / Solo

There are columns of check boxes to the left of the sliders. The left column, marked M, stands for

"mute" and the center column, marked S, stands for "solo." Each of the 16 check boxes in a column

corresponds to each of the 16 tracks in Sequence Panel.

If an M check box is selected, no sound will come from that track. If an S check box is selected, the

sound will come only from that track. If an S check box is selected, any selected M check boxes are

ignored.

Clicking the M or S button toggles the check status of “mute" or “solo”. Clicking the R button at the

bottom of each column deselects all the check boxes in that column.
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5.2.8 Couple

The C column of check boxes is used to couple tracks together. When the C boxes for several tracks

are selected, changing the position for one of the track sliders will change the slider positions for all of

the selected tracks. The couple feature allows you to change parameters on multiple tracks at once.

Clicking the C button toggles the check status of the couple functionality. Click the R button at the

bottom of this column to deselect all the check boxes in the column.

5.2.9 Pitch Range

The Pitch Range value can be modified when Pitch is selected from the drop-down list box above the

sliders. The Pitch Range determines how much you can change the pitch of a track. The initial value is

12 and has a range of ±12 half-tones. A smaller value narrows the pitch range but allows you to make

high-precision adjustments. A larger value increases the pitch range, but reduces the adjustment

precision.
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6 Sequence Variable Panel

6.1 About Sequence Variable Panel

The Sequence Variable Panel dialog box allows you to reference and write the “sequence variable”

variables that can be handled in the sequence data. The two types of sequence variables, local and

global, can be accessed through this dialog box. Because the interface is the same for both types of

variables, only one of them will be used as an illustration in this section.

To open the Sequence Variable Panel dialog box, click on Display and select either Sequence

Variable Panel or Global Sequence Variable Panel. The Sequence Variable Panel dialog box is

shown in Figure 6-1.

Figure 6-1 Sequence Variable Panel

6.2 Description of the Sequence Variable Panel Features

In the dialog box, each of the 16 items (numbered 0 to 15) corresponds to one of the 16 individual

sequence variables.

6.2.1 Referencing Variables

The current value for each of the variables is displayed to the right of the combo box. For local

variables, the variable cannot be obtained if the sequence is not playing currently. If a variable cannot

be obtained, a hyphen (-) will be displayed.
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6.2.2 Writing Variables

A variable’s value can be written by inputting a value in the combo box and clicking Write in the

bottom-right corner.

The check boxes indicate whether the variable will be written. Variables that are not selected will not be

rewritten when you click Write.

Clicking the X button will toggle the box state. Clicking R will clear the check boxes.

6.2.3 Writing During Sequence Playback

If you play back a sequence with the Sequence Variable Panel dialog box open for a local variable,

the value of the variables in the dialog box will be written at the same time the sequence is played back.

However, the value for the unselected check boxes will not be written.
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7 Sound System Settings

7.1 About Sound System Settings

Use the Sound System settings toolbar to add effects to sounds and to play sequences with

restricted channels. To make changes to the Sound System settings toolbar, from the View menu

select Sound System settings. The toolbar, shown in Figure 7-1, appears in the NITRO-Player window.

Figure 7-1 Sound System Settings

7.2 Output Effect

Use the Output Effect drop-down combo box to choose the output effect you want to apply to sounds.

Once the output effect is selected, it is immediately applied to the sound. The types of output effects

are shown in Table 7-1.

Table 7-1 Types of Output Effects

Option Description

Off The Output Effect feature is not used (the default setting)

Normal Normal (stereo) mode

Surround Surround sound mode

Headphone Headphone mode

Mono Mono mode

Channels 1 and 3 are used for output effects. Therefore, if you lock these channels using the feature for

restricting voicing channels (as explained below), you cannot select any Output Effect other than "Off." 

7.3 Restricting Sound Channels

Channel Lock is used to check the playback while restricting sound channels. Selected channels will

not be used for sound. Use this to check the sound for high-priority sounds when playback is restricted.

The number above each checkbox corresponds to the channel numbers used in the DS sound circuit.



NITRO-Player User's Manual

NTR-06-0258-001-B 30  2005-2007 Nintendo
Released: May 7, 2007 CONFIDENTIAL

7.4 Hard Disk Recording Feature

The waveform data from the Nintendo DS sound output, captured with sound capture, can be recorded

in real time to a PC hard disk. Because this feature uses sound capture, however, the output effects

must be set in advance to anything other than off.

To display the file dialog box, on the Sound System settings toolbar click Record. Enter a name for

the output file. The output waveform data will be in the WAV format.

When recording is finished, a dialog box will appear, displaying the recording results. If an error

occurred, the recorded waveform data will have skips because the PC and the DS communications did

not synchronize in time to record. Refer to paragraph 7.4.1 Avoiding Errors, and re-record the data.

7.4.1 Avoiding Errors

Adhering to the recommendations listed below will help you avoid common errors.

� Make the MCS server “Interval for Obtaining Data from the DS” as short as possible (16 ms is

recommended). For further details, refer to MCS Server Manual.

� During recording, avoid operations like loading data. Loading data needed for playback ahead of

time can reduce the frequency of errors.

� Avoid streaming playback. Errors are more likely to occur during streaming playback due to the

increased communication burden between the PC and the DS.

In general, avoid processes that place a burden on the PC during recording. This burden will slow

down the MCS server and errors will occur more frequently.
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8 Heap Simulation

8.1 About Heap Simulation

The heap simulation feature allows you to check how the state of a given heap will change when data

are loaded or deleted.

To perform a heap simulation, you must switch to the heap simulation mode. Data are loaded manually

in the heap simulation mode. Therefore, sequence playback will fail if the necessary data are not

loaded.

To go into the heap simulation mode, from the Display menu select Heap Simulation. The Heap

Simulation dialog box, shown in Figure 8-1, will open. As long as this dialog box is open, you are in the

heap simulation mode. As soon as the dialog box is closed, you will leave that mode.

Figure 8-1 The Heap Simulation Window

8.2 Heap Simulation Dialog Box

The Heap Simulation dialog box contains two large panes, current heap state in the left pane and the

data that you can select for loading in the right pane.
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8.2.1 Heap Meter

The red, yellow, and green bar meter on the left side of the Heap Simulation dialog box displays how

much of the overall heap is being used. The red color indicates that the region is in use. Yellow

indicates how much memory the data you want to load will consume when loaded. Green is the unused

region of the heap.

8.2.2 Heap List

The heap list pane on the left displays the contents of the data loaded to the heap.

To display the contents of the heap in the heap list, choose the hierarchy level using the level drop-

down combo box. Changing this value will allow you to view the contents of another hierarchy level.

8.2.3 Load Data List

The load list pane on the right displays the contents of the data that will be loaded.

The two drop-down combo boxes above this pane allow you to select what you want to load. Making a

selection will display the data to be loaded in this pane. If any data have already been loaded, a 0 will

appear in the Load Size column and the entry will be grayed out.

8.3 How to Operate Heap Simulation

8.3.1 Changing the Heap Size

The size of the sound heap must be configured. Click Change heap size and a dialog box for entering

the heap size will appear. After you enter the heap size, click OK.

8.3.2 Selecting the Data to Load

Using the two combo drop-down boxes above the load data list, select the data you want to load.

The first combo box allows you to select the type of data you want to load. You can select Group,

Sequence, Bank, WaveArc, or SeqArc.

Individual data can be designated with the bottom combo box.

Once you have made your selection, click Load and the data will load onto the heap.

8.3.3 Hierarchy Level Operations

The SaveState and LoadState operations can be performed on the heap.

Click SaveState to save the current heap state and to increase the hierarchy level by one.

Click LoadState to restore the current level to its initial state.
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8.4 Precautions for Sequence Playback

When you are not in the heap simulation mode, the sequence playback operations are the same.

However, if the data needed to play back a sequence are not loaded in advance, the sequence cannot

be played back.

If playback fails, an error message will be output to the MCS server window. For more details about this

error message, refer to paragraph 11.1 Error Messages.
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9 Conversion Feature

9.1 About the Conversion Feature

Once the sound data have been updated, they can be converted in NITRO-Player. The results of the

conversion are immediately reflected on NITRO-Player. However, to use the conversion feature, the

sound archive definition file (*.sarc) must be loaded, not the sound archive file (*.sdat).

9.2 Explanation of Operation

To convert the sound data, select Convert from the File menu. A dialog box shown in Figure 9-1 

appears and stays open while the data is being converted, and automatically closes when the

conversion process ends normally. The content displayed on NITRO-Player gets updated to the new

sound data. From this point, you can continue with operations the same way you did before the

conversion process.

If an error is generated during the conversion process, the dialog box will remain open and you will be

notified that an error has occurred. Read the error message and fix the sound data.

Figure 9-1 Conversion Errors
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9.2.1 Specifying Options and Converting

Selecting Specify Options and Convert from the File menu allows you to select which file types to

convert. For example, if only the SMF files were edited, you can decrease the conversion time by

specifying the conversion only for sequence files using Specify Options and Convert.

Selecting Specify Options and Convert will display the Convert Option dialog box, shown in

Figure9-2.

Figure9-2 Specifying the conversion options

Only the file types that you have checked will be converted.

Be absolutely sure to put a check by the file types of any edited files. If edited files are not converted,

incorrect data may be created.
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10 Other Features

10.1 Real-Time MIDI Playback

If the PC is connected to IS-NITRO-UIC MIDI or IS-AGB-MIDI, you can perform real-time MIDI

playback. If the hardware is properly connected, the "MIDI" message will appear on the status bar of

the main application window, as shown in Figure 10-1.

Figure 10-1 MIDI Indicator

For real-time MIDI playback, you must set the bank that will be used for playback. To do this, select the

BANK folder in the folder pane and then select the bank from the content pane. To register the

specified bank that will be used for MIDI playback, select MIDI bank from the Play menu. After these

steps are completed, the sound can be played by sending MIDI signals to the MIDI input of IS-NITRO-

UIC MIDI or IS-AGB-MIDI.

10.1.1 MIDI Reset

If you want to reset the MIDI status, select MIDI reset from the Play menu.

Carrying out a MIDI reset will stop the sound played by real-time MIDI playback, and the control

change value will be set to the default value.

10.2 Connecting / Disconnecting the Nintendo DS

When Nitro-Player starts, NITRO-Player normally connects to the DS automatically. However, if the

connection fails, NITRO-Player will start in the disconnected state. To attempt a connection to the DS,

from the Communications menu select Connect.

10.3 Nintendo DS Operations

Once playback becomes possible from the NITRO-Player application side, you can use the Nintendo

DS interface to control playback.

The DS controls are exactly the same as those for the NITRO-Composer SoundPlayer. (See the

NITRO-Composer documentation for more details.) However, Nintendo DS operations cannot be

performed in the heap simulation mode.
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11 Appendix

11.1 Error Messages

If a sequence fails to play back, an error message will appear in the MCS server window. Possible

error messages are listed in Table 11-1.

Table 11-1 List of Error Messages

Error Message Description

Low Priority Playback is not possible because a sequence with a higher priority is

currently playing.

Invalid Seq No Undefined sequence number.

Invalid SeqArc No Undefined sequence archive number.

Invalid Bank No Undefined bank number.

Invalid WaveArc No Undefined waveform archive number.

Invalid Group No Undefined group number.

Invalid SeqArc Index Undefined sequence archive index.

Invalid Stream No Undefined stream number.

Invalid Stream Player No Undefined stream player number.

Memory Over Insufficient memory. No more data can be loaded.

Too Large Data Playback is not possible because the amount of data is too large.

Not Found Wave Data Waveform data not found. (Heap Simulation Mode). 

Not Found Bank Data Bank data not found. (Heap Simulation Mode). 

Not Found Seq Data Sequence data not found. (Heap Simulation Mode). 

Not Found SeqArc Data Sequence archive data not found. (Heap Simulation Mode). 

Not Enough Player Heap for Wave The player heap is too small to load the waveform data.

Not Enough Player Heap for Bank The player heap is too small to load the bank data.

Not Enough Player Heap for Seq The player heap is too small to load the sequence data.
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